
Welcome To WinCover 

If You Send Paper Faxes Or Own A Fax Modem, You Need WinCover! 
WinCover is a useful Sharewareprogram for printing facsimile cover sheets under Windows 
3.1 or newer. It allows the user to set up default sender information which will load whenever
WinCover is started as well as the option to select alternate sender information. It also 
allows the user to set up a database of frequently used receivers along with their fax 
numbers. All records in this database may be printed or exported to a delimited ascii file. Fax
cover sheets may also be saved to disk for later reference. The user may opt to engage a log
file to record details of all printed cover sheets. A system to drag and drop Senders, 
Receivers, bitmap source files and saved cover sheets insures ease of use. All system fonts 
are supported. Custom bitmaps may be included on the cover sheet (postcript printers not 
supported for bitmap printing). Accurate positioning of the bitmap image, font sizing and 
page alignment is accomplished via a full WYSIWYGpage preview. All user configurable 
settings are saved in a standard .ini file format in the Windows directory. The TrueType font 
named Courier New must be installed on your system in order to print a correctly formatted 
list of all receivers in the database. The TrueType font named WingDings is also required. 
These fonts are included with Windows 3.1. Support is also included for WinFax Pro 3.0 or 
newer. You may print direct to WinFax as a means of exchanging quick messages or you may
use WinCover to generate an attachment file for use as a cover page with WinFax. 29 
custom bitmaps for cover sheet use may be obtained separately as WCVPIX.ZIP. 
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Files Included With WinCover 

These are the files that are included and their functions. An asterisk (*) indicates that this is 
a file necessary to the function of the program. A pound symbol (#) indicates that this file is 
installed by default in the Windows System directory. 

*WINCOVER.EXE - main program file. 
*WINCOVER.HLP - this help file. 
*DEFAULT.SND - the default sender data file. 
*RECEIVER.DB - the default receiver database file. 
#*STATUS.DLL - dynamic link library. 
#*PPFONT.DLL - dynamic link library. 
#*PSETUP.DLL - dynamic link library. 
#*BTTNCUR.DLL - dynamic link library. 
#*TOOLBUTT.VBX - custom control. 
#*3DLABEL.VBX - custom control. 
#*HMETER.VBX - custom control. 
#*VBDIA.VBX - custom control. 
SAMPLE.FCS - sample fax cover sheet file. 
ALT1.SND - an alternate sender example file. 
FAXHIST.LOG - fax history log file. 
README.TXT - initial instructions. 
SITE.WRI - corporate site agreement and order form. 
BASIC(1-6).BMP - six simple bitmap images. 
INSTALL.EXE - installation program. 
INSTALL.INF - standard installation data. 
CONVERT.EXE - a utlity for converting Sender and Fax data from WinCover 3.0. 
FILE_ID.DIZ - Standard BBS description file. 



Installation Instructions 

Execute INSTALL.EXE from within Windows. Install will create a sub-directory of your choice, 
copy all distribution files and create a Program Manager Group for WinCover if you desire OR
you may manually copy all distribution files to the directory of your choice & use Windows 
Program Manager or an equivalent process to install. Requires VBRUN300.DLL, not included -
(Can be downloaded from Compuserve, also available from most BBS's). 

29 custom bitmaps for cover sheet use may be obtained separately as WCVPIX.ZIP. 



VBRUN300.DLL is the Visual Basic Runtime Library Version 3.0 and is required to run any 
Visual Basic 3.0 program. (VBRUN100.DLL and VBRUN200.DLL were for version 1.0 and 2.0 
respectively). 



Upgrading From A Prior Version 

 WHEN UPGRADING FROM VERSION 3.0 OR 3.1: 
1> (3.0) Delete ENUMFONT.DLL from your disk. It was installed by default in the Windows 
System directory. 
2> Copy VBRUN300.DLL to your Windows System directory. VBRUN300.DLL is available from
Compuserve, AOL and most BBS's. 
3> Run INSTALL.EXE and place WinCover in a DIFFERENT directory than your current 
installation, copy your old data and bitmap files (.fax(3.0), .fcs(3.1)**, .db, .dat(3.0), .snd 
(3.1), .bmp) to the new directory. 

4> (3.0) RUN CONVERT.EXE IN THE NEW DIRECTORY to convert to the new Sender and Fax 
file formats. See the Help menu of CONVERT.EXE for further instructions. YOU MUST 
CONVERT YOUR OLD DATA TO USE THIS VERSION. 

 **IF YOU ARE UPGRADING FROM VERSION 3.1** 
Starting with version 3.1a there was a change of data sequencing in all .FCS (saved fax 
files). A bug in version 3.1 caused improper data sequencing in .FCS files if carriage returns 
were added to the notes section. This has been fixed in 3.1a or newer. Any .FCS files saved 
with version 3.1 will no longer be fully readable with 3.1a or newer with comments, date and
notes entries out of sequence. The only way to recover these files is to manually re-
sequence the data which is actually quite easy. IF YOU MUST RECOVER THESE DATA FILES, 
CONTACT THE AUTHOR FOR INSTRUCTIONS. 



Setting Up The Sender Information 

After starting the program for the first time you will want to change the default Sender to 
match your needs - click CLEAR SENDER. Fill out the Sender fields as you want them to 
appear each time the program is started. Click SENDER menu and click SAVE CURRENT AS 
DEFAULT - click Yes on the warning message box. The default Sender has now been saved in 
a file called DEFAULT.SND in the same directory as WINCOVER.EXE. 

You may save Alternate Senders as follows: Click CLEAR SENDER. Type in the alternate 
Sender. Click SENDER menu - click ADD SENDER AS ALTERNATE. You will be prompted to 
enter a file name for this alternate Sender - it must have a .SND extension! You may also 
enter a description of the Sender which will appear when you recall an alternate Sender later
(useful if many people are using the same Fax machine). Click OK - Repeat for as many 
Alternate Senders as you like and save each in it's own individual .SND file. The alternate 
Sender of your choice may now be recalled at any time by: Clicking the Sender menu, Click 
SELECT AN ALTERNATE SENDER. Click on the Sender of choice and drag it to the main 
program window or double click the Sender file of choice - (a sample called ALT1.SND is 
included with the program). Senders may be updated and deleted with the appropriate 
menu choices. The delete dialog box offers the option of dragging the Sender to a graphical 
trash can which opens for the Sender to be dropped in or you may simply double click or tap
the spacebar once the Sender is selected. 

You may also initiate the above functions using the appropriate Tool Barchoices. 



Setting Up Receivers 

The default Receiver data file, RECEIVER.DB, automatically loads when the program is 
started and since the database file with the package contains only the Author's fax number, 
you will want to add your own list of frequently used Receivers. Click CLEAR RECEIVER. Enter
your first Receiver - A COMPANY NAME MUST BE ENTERED & EACH FIELD IS LIMITED TO 25 
CHARACTERS. You may leave the TO ATTENTION OF field blank if you like but do fill in the 
RECEIVING FAX NUMBER field. Click ADD. Repeat until you have added all your Receivers. 
The total number of Receivers is limited to 500. 

Use FIND to locate the Receiver of choice - select the Receiver you wish to use from either 
the Company or Individual lists and then either drag the Receiver of choice to the main 
program window, double click it or tap the space bar and it will be loaded. 

If you want to change a saved Receiver's information, FIND the Receiver you wish to change,
type in the changes and click UPDATE. Changes will be written to the database. 

Should you wish to delete a Receiver click DELETE. The currently displayed Receiver will be 
erased from the database. 

The entire database of Receivers may be printed or exported to a delimited ascii file using 
the appropriate choices from the File menu. Printing the Receivers sorts the list by company 
name and includes the individual, if any, plus the fax number. The font for the title of the 
print-out is the default font for the cover sheet. The actual list text is pre-set to print using 
the Courier New TrueType font (included with Windows 3.1). This font must be present on 
your system for the list to be formatted properly. If you choose to export the Receiver 
database, a delimited ascii file named EXPORT.TXT is created in the directory where 
WinCover is installed. This file may be used to export database information to other 
programs. The format is as follows: 

"COMPANY","INDIVIDUAL","FAX NUMBER" 



Fax Cover Sheets 

The Fax Cover Sheets menu allows the current fax cover sheet to be saved to disk to a file 
with a *.FCS extension. You may enter comments in the SAVE FAX COVER TO DISK dialog 
box, the current date and time are also saved. Saved fax cover sheets may be recalled or 
deleted with the appropriate menu choices or the Tool Bar. A sample fax cover sheet, 
SAMPLE.FCS is included with the package. This feature is not to be confused with the 
separate feature to automatically create a log file (discussed in the General 
Configurationsection). 



The Notes (Message) Field 

The notes multi-line text box will hold up to 15 lines of text. Should you exceed this limit you
will be reminded of the limit by a warning message at print time. The text box automatically 
wraps any text that is entered. Please read the additional instructions for proper text width 
adjustment in the Print Preview/Bitmap & Page Setupsection. 

The Notes section can be retracted or extended to reduce the interface size with the blue 
vertical arrow buttons on the right of the main screen. 



General Configuration 

The General Configuration and File menus provides the following options: 

All Data Upper Case or All Data Mixed Case 
This affects the option of having all data entered into fields converted to upper case 
regardless of your keyboard caps lock setting. 

Fax Log File Active or Fax Log File Inactive 
This will automatically record key information when printing a cover sheet including date, 
time, receiving company, receiving individual, fax number, number of pages transmitted and
all notes. The resulting file may be viewed or printed via the appropriate selection from the 
File menu (Windows Notepad must be installed on your system for this feature). This option 
is in addition to the option to save the entire cover sheet from the Fax Cover Sheets 
Menu(you will be given the option after printing to save the cover sheet in a .FCS format file 
whether or not the entry was logged in the FAX.LOG file). 

Date Format 
Presents you with a sub-menu of two date formats for use by the program. MM/DD/YY or 
DD/MM/YY. This was incorporated due to many requests from users in countries that use the 
DD/MM/YY format. 

All of the above settings are saved as defaults upon exiting the program. 

The File menu contains an option for changing the default system printer and it's setup. Be 
aware that if you change the default system printer while WinCover is running, incorrect font
name information may be displayed in the preview screen. Exit and re-start WinCover to 
update the displayed font names. 

C O L O R S 
WinCover's color defaults are those as set for your system in Windows Control Panel. 



Using WinCover With A Fax Modem 

WinFax Pro 3.0 or newer most be installed on your system to use the built in DDE support. If 
WinFax is not installed, the Fax Modem menu selection in the main and preview screens will 
be disabled. You can use the Printer Setup menu selection to change the default printer to 
your fax driver. Consult your software documantation on proper procedure for creating an 
attachment file. 

 Print Message Direct To WinFax Pro 

This is useful if you want to compose a quick message and send it as a single page. When 
you click Print Direct To WinFax Pro your default system printer is automatically changed to 
WinFax and this dialog box will appear. You may now edit the destination telephone number, 
transmission date & time, subject of the fax and the fax resolution. Click Send Fax and your 
message will be sent and your original default printer driver will be restored. Be careful to 
maintain the displayed format for time and date if you want to schedule transmission in the 
future. Incorrect formatting here will cause a DDE error message to be displayed. 

 Create Attachment File For WinFax Pro 
This feature allows you to create cover sheets for use with WinFax. When you click this menu
selection a dialog box will appear giving you the option of restoring your default printer 
driver when the attachment printing is complete. When the WinFax dialog box appears 
choose SAVE TO FILE under ATTACHMENTS. Refer to your WinFax documentation for 
instructions on how to attach the cover sheet to other transmissions. 



The Floating Tool Bar 

The Floating Tool Bar performs the following functions: 

Some buttons are disabled depending upon which screen you are currently using. 

The float/sink menu is provided so that the user may force the Tool Bar to stop floating. The 
Tool Bar will automatically sink when the Receiver list is called, if WinCover Help is called and
for most program message boxes. This feature is useful if multiple applications or a screen 
saver are running and you find that the Tool Bar is overlapping them. The float/sink menu is 
disabled in the Print Preview/Bitmap & Page Setup screen. 

The Tool Bar may be rolled up or down to save screen space using the blue (unrolled) and 
yellow (rolled) vertical arrows. 



Print Preview/Bitmap & Page Setup 

This screen provides for all page, font and bitmap settings. Provision is made for margin 
adjustment, bitmap selection, placement and sizing, font size adjustments for the To/From 
and Message areas of the cover sheet as well as selection of a text title if no bitmap is to be 
printed. 

Alignment 
Provision can be made for the print alignment of different printers. Adjust the PAGE L (left) 
and PAGE T (top) controls to your needs. Please note that this adjustment will show 
immediately in the preview but the actual representation of the margins will vary with 
different printers. This adjustment is independent of the bitmap size and position settings. 

Bitmaps 
Bitmap source files can be selected via the BITMAP FILES menu. Either drag or double click 
your choice in the dialog box to load the bitmap. Use the BITMAP T (top), L (left), H (height) 
and W (width) controls to size and position the bitmap. Please note that you must click the 
Resize button after making height or width adjustments, whereas top and left adjustments 
are shown immediately in the preview. The BITMAP FILES menu and these controls are 
disabled if the ENABLE BITMAP PRINTING option button on the Tool Baris not depressed. 
Please note that printing times will increase substantially when printing bitmap images. 
Some grey scale bitmaps (including some in the WCVPIX.ZIP. archive, available separately) 
do not display well in the preview but do print properly. 

Fonts 
You may set the font size of the TO & FROM, MESSAGE and TEXT TITLE sections 
independently. You will note occasionally that some font size selections will not actually 
change the size of the displayed fonts in the preview. This will vary with different TrueType 
font names and manufacturers and is due to the way Windows handles small fonts. The 
actual printed font sizes will be as selected. Please note that the MESSAGE section prints 
approximately 60 characters across and the font size will have to be adjusted depending on 
the width of the font selected. The TEXT TITLE controls allow for the user to select a title to 
be included on the cover if no bitmap is desired. The TEXT TITLE controls are disabled if the 
ENABLE BITMAP PRINTING option button on the Tool Baris depressed. 

Use the BOLD and ITALIC buttons on the Tool Bar to change the text attributes of the printed 
page. Due to Visual Basic's TrueType font handling procedures, fonts of less than 17 point in 
the preview will always be represented as Bold, however, the actual printed page will be 
accurate. Please note that the actual words To:, From:, Message: and all individual field 
labels are not affected by Bold settings. WinCover has only been tested with Truetype fonts. 

Border 
You may also disable the FIELD BORDER button on the Tool Barto eliminate the borders 
printed around the various fields on the cover sheet. This may help to reduce print times. 

Clicking the Ok button returns you to the main program screen with all changes made to the 
preview screen being retained. You may choose the Print button on the Tool Bar from either 
the Preview or Main screens. 

All of the above settings are saved as defaults upon exiting the program. 



Should you wish to have your company logo digitized, you may order this service from the 
Author using the ORDER LOGO SCANNING menu selection from the Help menu. 



How To Get A Message To The Author 

You may send the Author a fax with your thoughts, suggestions, ideas, complaints, etc. Fax 
the report to the Author via the number below. Please include a brief description of your 
system if you have a technical question, problem or bug to report. You may also leave any 
questions, comments or suggestions for the author on Compuserve: 

Graphic Impact,    Michael Haschka - Compuserve 73027,3307    OR    America Online at 
MikeH1259    OR      Fax (805) 482-6213 

The author's mailing address is: 

Graphic Impact 
5241 Mission Oaks Blvd., Suite 377 
Camarillo, CA    93012-5425    U.S.A. 



Trouble Shooting And Known Bugs 

If the default Sender file is missing you will receive an error message at startup. Simply type 
in a new default Sender and use the Sender menu to save it as the Default. Should the 
Receiver database file RECEIVER.DB be missing the program will automatically create a new 
empty database file at startup. Most other error messages received during usage of 
WinCover should be fairly self explanatory - if not, refer to the How To Get A Message To The 
Authorsection for ways to reach the author. 

Postscript printers are not supported for printing of bitmaps. If you have a Postscript printer, 
simply select no logo from the print dialog and print your cover sheet with text only. There 
have been some problems with Norton Desktop reported with this and other Visual Basic 
programs including WinCover being unable to find the default data files. If using Norton 
Desktop, you MUST select File Properties and then click on Options - set the directory where 
WinCover and it's data files are located. Failure to do this will cause an error message to be 
displayed at startup. If you start WinCover and then change printers or page orientation 
while it is running, you may encounter problems with the Preview Screen font list not 
reporting the correct fonts. This will depend upon which printer has been selected. PLEASE 
let me know if you encounter any bugs or problems - Send me a fax. 

The TrueType font named Courier New must be installed on your system in order to print a 
correctly formatted list of all receivers in the database. This font is included with Windows 
3.1. 

WinCover has only been tested extensively with Truetype fonts. Please make the Author 
aware of any problems with other font types. 

The following printer drivers/fonts have proven incompatible as of 02/93: 

Panasonic 4450 - TrueType fonts do not print properly, bitmap does not print. Use the HP 
LaserJet driver instead. 
SuperPrint - Large fonts do not print properly, bitmap does not print. Nimbus Q typefaces 
supplied with package are incompatible. 



Acknowledgements 

My special thanks to Microhelp Inc. for their bitmap printing routines, to Ed Staffin for 
STATUS.DLL, to Paul F. Poellinger for PPFONT.DLL, to Michiel De Bruijn for his code ideas in 
SIMPLFAX, to Richard Wagner for his code ideas in Pwrap, to Jari Kallonen for VBINST, to Brett
Foster for TOOLBUTT.VBX, to Mike Kasaty for his timely help with database file 
manipulations, to Mark Gamber for VBDIA.VBX, to Jiang, Jeng Long for HMETER.VBX & 
3DLABEL.VBX and to my girlfriend Kim who put up with my long hours in writing WinCover! 



Warranties And Legal 

MICHAEL HASCHKA AND GRAPHIC IMPACT MAKES NO WARRANTIES, EXPRESS OR 
IMPLIED, AND SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANT 
ABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE. The customer's sole 
remedies are set forth in the warranty clause above. The liability of Michael 
Haschka and Graphic Impact for damages shall not exceed the current 
registration fee for the product. In no event will Michael Haschka and Graphic 
Impact be liable for any special, incidental or consequential damages even if 
Michael Haschka or Graphic Impact has been advised of the possibility of the 
same. MICROSOFT WINDOWS, WINDOWS, MICROSOFT and VISUAL BASIC are 
registered trademarks of Microsoft Corporation. WINFAX and WINFAX PRO are 
registered trademarks of Delrina Corporation. All other product names are 
copyright and registered trademarks/trade names of their respective owners. 



Shareware Distribution 

Individuals, Shareware distributors and BBS operators may freely distribute WinCover 
provided the following criteria are met: 

ALL FILES THAT CAME WITH THE DISTRIBUTION DISKETTE OR ARCHIVE MUST REMAIN A PART 
OF THE PACKAGE. 
Please see  Files Included With WinCoverfor a complete list. 
PLEASE MAINTAIN THE FOLLOWING FILE NAME FOR DISTRIBUTION:      WCV31E.ZIP. 

To verify that you have the most recent version or if you have any questions, please see How
To Get A Message To The Author



All Other Countries Including U.S. 

WinCover is not PUBLIC DOMAIN NOR FREE SOFTWARE! It is provided for limited use for the 
purpose of evaluation only. Non-registered users of this software are granted a limited 
license to use an evaluation copy for trial use on a private non-commercial basis for the 
expressed purpose of determining whether WinCover is suitable for their needs. At the end 
of the 30 day trial period you should register your copy or discontinue using this product. 
When you register, you will receive a version of WinCover which omits the shareware 
notices, technical support, a free upgrade to the next major revision and automatic 
notification of new versions. 

The registration fee is a very nominal $20 plus shipping for single users. You may register via
Compuserve, America Online, by mail or fax (credit card orders only via AOL & fax). We 
accept VISA and MasterCard. To register by mail or fax use the Order option from the Help 
menu and choose United States And All Other Countries. To register on Compuserve (no 
shipping charges) type GO SWREG and search on #987. The registration fee will be charged 
to your Compuserve account. 

 AS A BONUS WHEN YOU REGISTER: If you register via the mail or fax (i.e. not on 
CompuServe) we will send you a certificate for a discount on a great collection of shareware 
on CD-ROM. This certificate entitles you to one issue of the 'JCSM Shareware Collection' for 
$9.95 plus shipping ($2 in the US, $3 in Canada, $5 elsewhere).    This is a great price on a 
great collection of shareware! 

The prices for non-european network or multi user site versions are as follows: 
2 to 9 computers .......... at $15 each 
10 to 24 computers ...... at $13 each 
25 to 49 computers ...... at $12 each 
50 to 99 computers ...... at $10 each 
100 or more computers .... $1000 one time fee 

A non-european corporate site license order form and agreement is included in the archive 
as SITE.WRI. 

If you have any questions please see How To Get A Message To The Author



 French Speaking Europe 

WinCover is not PUBLIC DOMAIN NOR FREE SOFTWARE! It is provided for limited use for the 
purpose of evaluation only. Non-registered users of this software are granted a limited 
license to use an evaluation copy for trial use on a private non-commercial basis for the 
expressed purpose of determining whether WinCover is suitable for their needs. At the end 
of the 30 day trial period you should register your copy or discontinue using this product. 
When you register, you will receive a version of WinCover which omits the shareware 
notices, technical support, a free upgrade to the next major revision and automatic 
notification of new versions. 

The registration fee is a very nominal 275 FF for single users. We accept credit cards. To 
register by mail or fax use the Order option from the Help menu and choose French Speaking
Europe. 

Please contact us for European network or multi user site pricing: 
WindowShare SARL 
B.P. 2078 
57051-METZ cedex 2 
France 
Fax:(+33)87 32 37 75 
Vox:(+33)87 30 85 57 
Minitel 3615 WinShare 

If you have any questions for the author please see How To Get A Message To The Author



WYSIWYG is an acronym for What You See Is What You Get. 



Shareware gives users a chance to try software before buying it. If you try a Shareware 
program and continue using it, you are expected to register. 






